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Гарантийные обязательства МАРАФОНА.   

ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА
(Ограниченная гарантия на продукцию МАРАФОНА)

 

Программное обеспечение:
Гарантийное обслуживание по программному обеспечению можно получить, связавшись
с офисом МАРАФОНА в оговоренный гарантийный период. Адрес офиса МАРАФОНА
приведен  на  первой  странице  Руководства  по  эксплуатации  устройства,  а  также
приложен вместе с Регистрационной карточкой. 

МАРАФОН гарантирует, что его программное обеспечение будет работать в строгом
соответствии с прилагаемой к нему МАРАФОНОМ документацией в течении девяноста
(90) дней с момента его приобретения у МАРАФОНА или Авторизованного Реселлера.
МАРАФОН предоставляет гарантию на носитель, на котором поставляется программное
обеспечение, в виде отсутствия потери им информации на тот же гарантийный срок.
Данная гарантия имеет отношение только к приобретенному программному обеспечению
или его замене по гарантии,  и  не касается  любых обновлений или замен,  которые
получены через Internet или бесплатно.

Ответственность  МАРАФОНА  по  обеспечению  гарантии  программного  обеспечения
состоит  в  замене  его  на  новое,  которое выполняет  перечисленные  в  прилагаемой
документации функции. Ответственность Заказчика состоит в выборе соответствующего
приложения,  программной  платформы/системы  и  дополнительных  материалов.
МАРАФОН  не  отвечает  за  работоспособность  программного  обеспечения  вместе  с
любыми  аппаратными  средствами  и/или  программными  платформами/системами,
которые поставляются третьими сторонами, если совместимость с ними не оговорена в
прилагаемой  к  продукции  МАРАФОН  документации.  Согласно  данной  гарантии,
МАРАФОН  старается  обеспечить  разумную  совместимость  своей  продукции,  но
МАРАФОН  не  несет  ответственность,  если  с  аппаратными  или  программными
средствами третьих фирм  происходят  сбои.  МАРАФОН  не гарантирует,  что  работа
программного  обеспечения  будет  непрерывна  и  в  процессе  не  будут  происходить
ошибки,  а  также  то,  что  все  дефекты  в  программном  продукте  с  или  без  учета
документации на него, будут исправлены.

Ограничения гарантий
Вышеупомянутые гарантии и замечания являются исключительными и соответствуют
всем прочим гарантиям, объявленным или подразумеваемым, которые даются в явном
виде или в соответствии с законодательством, установленными законами или в другом
виде,  включая  гарантии  на  сам  товар  и  его  пригодность  для  стандартных  целей.
МАРАФОН  никогда не  допускает и  не принимает  на себя  прочую ответственность,
связанную  с  продажами,  поддержкой  инсталляции  или  использования  продукции
МАРАФОНА

МАРАФОН  никогда  не  несет  ответственность  по  гарантии,  если  проводимое  им
тестирование и анализ определяет, что заявленный дефект в изделии не был обнаружен,
или  он  был  вызван  неверным  использованием  заказчиком,  или  третьей  стороной,
невнимательной или неправильной инсталляцией или тестированием, попыткой ремонта
неавторизованными  лицами,  или  чем-либо еще,  не  предусмотренным  в  назначении
изделия, типа несчастного случая, огня, пожара и других бедствий. 
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Ограничения ответственности
Ни в  каком случае МАРАФОН  не несет ответственность  за любые убытки, включая
потерю  данных,  потерю  прибыли,  стоимости  покрытия  или  других  случайных,
последовательных  или  непрямых  убытков,  являющихся  следствием  инсталляции,
сопровождения,  использования,  производительности,  неисправности  или  временной
неработоспособности изделий производства МАРАФОНА. Эти ограничения действуют,
даже если МАРАФОН был предупрежден о возможности такого убытка. 

Регистрационная карточка, прилагаемая на обратной стороне Руководства, должна быть
отправлена в офис МАРАФОН по факсу, электронной почте или почтовым отправлением.
Список адресов/ телефонов/ факсов офисов МАРАФОНА содержится на первой странице
данного Руководства.

Юр. адрес: 117330 Москва, ул. Мосфильмовская, дом 17Б.
Факт. адрес: 119899 Москва, Ленинске горы, МГУ, НИИЯФ, д.1. стр.5. 
Тел. (495)-988-27-26, 939-56-59, 939-13-24 
Факс. (495)-939-56-59
E-mail: support@marathon.ru 
WEB: www.marathon.ru 

По техническим вопросам звоните по тел. +7 (495)-988-27-26, 939-56-59, 939-13-24 или 
свяжитесь с нами по email support@marathon.ru. 
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Лицензионное соглашение на Программное
обеспечение, поставляемое с CAN интерфейсами

производства МАРАФОН

Все права на программное обеспечение, аппаратное обеспечение
и  данное  руководство  принадлежат  фирме  Марафон  и
защищены законодательством Российской Федерации.
ПЕРЕД  ИСПОЛЬЗОВАНИЕМ  ПРИЛАГАЕМОГО  ИЗДЕЛИЯ
ПОКУПАТЕЛЬ  ДОЛЖЕН  ВНИМАТЕЛЬНО  ОЗНАКОМИТЬСЯ  С
УСЛОВИЯМИ  НАСТОЯЩЕГО  СОГЛАШЕНИЯ.  ИСПОЛЬЗОВАНИЕ
ДАННОГО  ИЗДЕЛИЯ  ПОДРАЗУМЕВАЕТ  ПРИНЯТИЕ  ЭТИХ
ПОСТАНОВЛЕНИЙ  И  УСЛОВИЙ.  ЕСЛИ  ОГОВОРЕННЫЕ  УСЛОВИЯ
ЯВЛЯЮТСЯ  ДЛЯ  ПОКУПАТЕЛЯ  НЕПРИЕМЛЕМЫМИ,  ОН ДОЛЖЕН
НЕЗАМЕДЛИТЕЛЬНО ВЕРНУТЬ НЕИСПОЛЬЗОВАННЫЙ КОМПЛЕКТ,
ПРИ ЭТОМ ЗАТРАТЫ ПОКУПАТЕЛЯ БУДУТ ВОЗМЕЩЕНЫ.
ДАННЫЙ  ДОКУМЕНТ  ЯВЛЯЕТСЯ  ЛИЦЕНЗИОННЫМ
СОГЛАШЕНИЕМ,  НО НЕ СОГЛАШЕНИЕМ О ПРОДАЖЕ.  МАРАФОН
ЯВЛЯЕТСЯ  ВЛАДЕЛЬЦЕМ  ИЛИ  ИМЕЕТ  ЛИЦЕНЗИОННЫЕ
СОГЛАШЕНИЯ С ДРУГИМИ ВЛАДЕЛЬЦАМИ АВТОРСКИХ ПРАВ НА
ПРОГРАММНОЕ  ОБЕСПЕЧЕНИЕ,  ВХОДЯЩЕЕ  В  КОМПЛЕКТ
ПОСТАВКИ  СВОИХ  ИЗДЕЛИЙ  И  ПО.  ПОКУПАТЕЛЬ  НЕ
ПРИОБРЕТАЕТ  НИКАКИХ  ПРАВ  НА  ИНТЕЛЛЕКТУАЛЬНУЮ
СОБСТВЕННОСТЬ,  СОДЕРЖАЩУЮСЯ  В  ПРОГРАММНОМ
ОБЕСПЕЧЕНИИ,  ЗА ИСКЛЮЧЕНИЕМ ТЕХ,  КОТОРЫЕ  НАСТОЯЩЕЕ
СОГЛАШЕНИЕ  ПРЕДОСТАВЛЯЕТ  ЕМУ  В  ОТНОШЕНИИ  ЭТОГО
ПРОГРАММНОГО  ОБЕСПЕЧЕНИЯ.  ПРАВО  СОБСТВЕННОСТИ  НА
ПРИЛАГАЕМУЮ  КОПИЮ  УПОМЯНУТОГО  ПРОГРАММНОГО
ОБЕСПЕЧЕНИЯ,  А  ТАКЖЕ  НА ВСЕ  КОПИИ,  СДЕЛАННЫЕ  С  НЕЕ,
СОХРАНЯЕТСЯ  ЗА  МАРАФОНОМ ИЛИ  ДРУГИМИ  ВЛАДЕЛЬЦАМИ
АВТОРСКИХ  ПРАВ.  ПОКУПАТЕЛЬ  ПРИНИМАЕТ  НА  СЕБЯ  ВСЮ
ОТВЕТСТВЕННОСТЬ  В  ОТНОШЕНИИ  ВЫБОРА  ПРОГРАММНОГО
ОБЕСПЕЧЕНИЯ  ДЛЯ  ДОСТИЖЕНИЯ  СВОИХ  ЦЕЛЕЙ,  А  ТАКЖЕ  ЗА
УСТАНОВКУ, ИСПОЛЬЗОВАНИЕ И РЕЗУЛЬТАТЫ ИСПОЛЬЗОВАНИЯ
ДАННОГО ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ.
Покупатель имеет право:
1.  копировать  Программное  обеспечение  исключительно  для  создания
резервных  копий  или  при  установке  для  подразумеваемого  обычного
использования Программного обеспечения при условии, что в любой копии
упомянутого  Программного  обеспечения  будут  воспроизведены  все
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уведомления  об  авторских  правах  и  торговых  марках,  содержащиеся  в
данном Программном обеспечении;
2. передавать право владения копиями Программного обеспечения другому
юридическому  или  физическому  лицу  путем  передачи  данной  копии
настоящего Соглашения и всей прочей документации, а также по меньшей
мере  одной полной и  не  претерпевший изменений копии Программного
обеспечения,  при  условии,  что  (1)  все  сделанные  Покупателем  копии
Программного  обеспечения  будут  переданы  означенному  лицу  или
уничтожены, (2) такая передача права владения прекращает лицензионное
соглашение Покупателя с МАРАФОНОМ, и (3) означенное лицо примет на
себя и будет соблюдать постановления данного лицензионного соглашения
с момента начала пользования Программным обеспечением; и
3. использовать торговые марки, связанные с Программным обеспечением,
исключительно в соответствии с существующей практикой использования
торговых марок, включая ссылки на имена владельцев торговых марок.
Без письменного согласия МАРАФОНА запрещается:
1.  использовать,  копировать,  изменять,  объединять или передавать копии
данного  Программного  обеспечения  при  условиях,  отличных  от
оговоренных в данном соглашении;
2. деассемблировать или декомпилировать Программное обеспечение;
3.  выдавать  сублицензию,  сдавать  в  аренду  и  лизинг,  передавать  в
пользование данное Программное обеспечение или любую его копию.

Копирование  этого  руководства  возможно  только  при  получении
письменного разрешения у фирмы Марафон.
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CANwise                                                          Введение

1. ВВЕДЕНИЕ

CANwise  - универсальное  приложение  тестирования  и
конфигурирования  сети  CAN,  с  графическим
пользовательским  интерфейсом.  Конкретная
функциональность программы определяется плагинами (plug-
ins).  В  базовой  версии  CANwise поставляется  с  плагином
монитора  сети  CANmonitor,  который  позволяет  работать  с
CAN на  канальном  уровне.  Дополнительные  плагины
поставляются отдельно со своей документацией по установке
и использованию.

Этот  документ  описывает  установку  и  использование
CANwise в операционных системах Windows 8.1/10, Linux.
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2. УСТАНОВКА

Для  доступа  к  сети  CANwise использует  библиотеку  CHAI,
которая  должна  быть  установлена  отдельно;  руководство
пользователя  библиотеки  доступно  в  электронном  виде  на
сайте  http  ://  can  .  marathon  .  ru  /;  это  руководство  также входит  в
состав дистрибутива CHAI. 

2.1. ОС Windows

Начиная  с  версии  3.14,  CANwise  для  ОС  Windows
поставляется в 64-х разрядных исполняемых кодах и требует
библиотеки  CHAI  версии  не  ниже  2.11.4  (начиная  с  этой
версии  CHAI  для  Windows  поддерживает  64-разрядные
пользовательские приложения). 

1. Удалите  предыдущую  версию,  для  этого  запустите
мастер  удаления:  Start->Programs->CANwise-3.x-
>Uninstall.

2. Запустите исполняемый файл  CANwise-3.x-win64.exe и
следуйте инструкциям установщика. 

2.2. ОС Linux

Для  использования  CANwise в  ОС  Linux  необходимы:
установленная GUI-библиотека  GTK+ версии  2.x, архиватор
tar  и  программа  make.  Поскольку  Linux  является  ОС
ориентированной  на  поставку  программного  обеспечения  в
исходных кодах,  а  CANwise поставляется  в  бинарном  виде,
фирма  Марафон  не  гарантирует  работоспособности
приложения  во  всех  дистрибутивах  ОС  Linux.  Сведения  о
дистрибутиве Linux и версии библиотеки GTK+, которые были
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использованы  при  разработке содержатся  в  файле  version  в
корне дистрибутива CANwise.

Для установки  требуются права root.  Скачайте архив canwise-
3.x-linux.tar.gz и распакуйте его в директорию /opt командой.

tar -C /opt -xzvf canwise-3.x-linux.tar.gz

Перейдите  в  директорию  куда  был  распакован  архив  и
выполните команду make install

cd /opt/canwise-3.x-linux

make install

10
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3. УДАЛЕНИЕ

3.1. ОС Windows

Запустите мастер удаления:

Start->Programs->CANwise-3.x->Uninstall CANwise.

3.2. ОС Linux

Для удаления дистрибутива выполните команду make uninstall,
находясь  в  установочной  директории,  затем  удалите
установочную директорию.

cd /opt/canwise-3.x-linux

make uninstall
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4. ИСПОЛЬЗОВАНИЕ CANWISE 

4.1. Запуск

Для запуска в ОС Windows используйте 

Start->CANwise-3.x->canwise

Для запуска в ОС Linux наберите в терминале команду canwise

canwise

При запуске  выводится диалог  выбора  канала  ввода/вывода
CAN.

CANwise для доступа к сети использует библиотеку  CHAI, в
которой каждый  CAN-контроллер рассматривается  как
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отдельное  устройство  и  ему  в  соответствие  ставится
независимый канал ввода-вывода CAN. 

Диалог  выбора  канала  выводит  список  обнаруженных
библиотекой  CHAI аппаратных  CAN-интерфейсов  и  каналов
ввода-вывода, которые им соответствуют. 

В столбце «Сост. канала [Chan state]» выводится информация
о  занятости канала  в  момент  запуска.  Для  обновления
информации необходимо перезапустить CANwise.

В столбце «Серийный № [Serial number]» выводится серийный
номер  устройства,  в  настоящий  момент  поддерживается
только устройствами CAN-bus-USBnp. 

Переключатель  «Формат  кадра [Frame  format  to  use]»
позволяет  выбрать один из  трех доступных форматов  CAN-
кадров  с  которыми  предполагается  работать.  Выбранный
формат  влияет  на  работу  приемного  фильтра  CAN-
контроллера  (об  установке  фильтра  смотрите  пункт
“Управление  каналом  ввода-вывода  CAN”).  Некоторые
контроллеры позволяют использовать кадры обоих форматов
одновременно,  например  Phillips SJA1000,  но  при  этом
алгоритм  работы  приемного  фильтра  несовместим  между
форматами  кадров.  В  библиотеке  CHAI (и  в  CANwise
соответственно) существуют три режима работы:

• только  11-битовые  идентификаторы  -  возможность
посылать/принимать  только  кадры  стандартного
формата;  функция  установки  фильтра  использует
алгоритм для стандартного формата.

• только  29-битовые  идентификаторы  -  возможность
посылать/принимать  только  кадры  расширенного
формата;  функция  установки  фильтра  использует
алгоритм для расширенного формата.
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• оба  формата  одновременно  -  возможность
посылать/принимать  кадры  как  расширенного,  так  и
стандартного  формата;  функция  установки  фильтра
использует алгоритм установки для СТАНДАРТНОГО
формата,  при  этом  действие  фильтра  на  кадры
расширенного формата непредсказуемо.

Кнопка   «Загрузить  сессию  [Load  Session]»  позволяет
загрузить сохраненный ранее сеанс работы (см. пункт «Работа
с сеансами»).

В  случае,  если  библиотека  CHAI не  смогла  обнаружить  ни
одного аппаратного интерфейса, CANwise выводит сообщение
об ошибке и завершает работу.
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4.2. Главное окно

После выбора канала выводится главное окно. В левой части
окна  находятся  кнопки  управления  каналом  ввода-вывода  -
«Управление  каналом  [CAN channel controls]»,  индикаторы
ошибок  сети -  «Ошибки  CAN  [CAN  errors]» и  список
отображающий  состояние  канала  ввода-вывода  -
«Информация о  канале  [CAN channel information]». В правой
части окна находится рабочая область плагинов.
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4.3. Управление плагинами

Пункт  меню «Плагины->Настроить   [Plugins->Configure]»
выводит диалог списка обнаруженных плагинов.

По умолчанию, в стандартной поставке, это будет список из
одного  модуля  CANmonitor  – монитора сети CAN. Каждый
плагин из списка можно загрузить нажатием кнопки «Открыть
[Load]».

Загруженный  модуль  можно  выгрузить  нажатием  кнопки
«Закрыть [Release]».
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4.4. Управление каналом ввода-вывода CAN

• Кнопка  «Старт/Стоп  [Start/Stop]»  переключает
состояние  CAN-контроллера:  RUNNING - INIT. После
запуска  программы  CAN-контроллер  находится  в
состоянии  INIT,  в котором он “отключен” от сети (не
участвует в обмене данными и в механизме контроля и
предотвращения ошибок). В этом состоянии возможна
настройка контроллера (установка приемного фильтра,
скорости  передачи,  включение/отключение  режима
«прослушки»  Listen Only Mode).  В  состоянии
RUNNING контроллер находится в рабочем режиме и
участвует в  полноценном  обмене данными с другими
узлами сети; настройка контроллера в этом состоянии
невозможна.

• Кнопка «Вкл. LOM/Выкл.  LOM [Set  LOM/Clear LOM]»
переключает режим «прослушки» Listen-Only-Mode.  В
этом  режиме  контроллер  принимает  проходящие  по
сети кадры, но не участвует в  работе шины (не шлет
кадры  подтверждения  и  ошибок).  Этот  режим
используется  для  не  возмущающего  анализа  трафика
сети. Передача кадров в режиме LOM невозможна.

• Кнопка «Сброс  [Reset]» производит аппаратный сброс
CAN-контроллера;  сбрасываются  все  аппаратные  и
программные  счетчики  ошибок  и  переполнений,  а
также  индикаторы  ошибок  сети  CAN;  скорость
передачи, аппаратный фильтр и состояние контроллера
(INIT/RUNNING) сохраняются.
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4.5. Параметры канала ввода-вывода CAN

• Пункт меню «Битовая скорость [Bit rate]» вызывает 
диалог установки скорости передачи (по умолчанию 
скорость передачи равна 500 Кбит/сек).

Диалог позволяет выбрать из списка одну из 
предопределенных CiA скоростей передачи, либо, 
выбрав пункт “Manual Set”, выставить значение 
регистров bt0 и bt1 для задания нестандартной 
скорости (более подробно значения регистров bt0 и bt1 
и процедура расчета скорости описана в документации 
контроллера SJA1000). 
Кнопка «Авто-определение [Autobaud]» вызывает 
диалог автоматического определения скорости 
передачи (тестируются только предопределенные CiA 
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скорости). Для работы алгоритма авто-определения 
CAN-контроллер должен быть подключен к сети по 
которой идет активный обмен данными.
 

Поле «Тайм-аут ожидания [Wait timeout]» задает время 
в течении которого CANwise будет ждать появления в 
сети кадра для каждой тестируемой скорости. Поле 
«Метод [Method]» задает метод подключения к сети во 
время работы алгоритма: «Не разрушающий (LOM) [No
distorb]» - подключение в режиме Listen Only Mode 
(гарантирует невмешательство в текущий сетевой 
трафик), «Разрушающий [Distorb]» – обычное 
подключение с посылкой кадров ошибок (не 
рекомендуется поскольку может нарушить текущую 
работу сети). В случае успешного обнаружения  
скорость устанавливается по окончанию работы 
алгоритма.

• Пункт меню «Приемный фильтр [Acceptance Filter]» – 
вызывает диалог установки приемного фильтра CAN-
контроллера.
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Текущая версия CANwise поддерживает фильтр как для
кадров стандартного формата (идентификатор – 11 
бит), так и для кадров расширенного формата  
(идентификатор – 29 бит). 
Следует учитывать (как уже указывалось выше), что 
при открытии канала в режиме работы с обоими 
форматами используется алгоритм для 
СТАНДАРТНОГО ФОРМАТА, действие фильтра на 
кадры расширенного формата непредсказуемо.  

Аппаратный фильтр состоит из двух значений: Filter 
code (acode) - значение фильтра, и Filter mask (amask) - 
значение маски. Значение фильтра задает 
идентификатор принимаемых кадров. Маска задает 
значащие позиции в значении фильтра. Если бит номер
N в маске выставлен в 1, то бит номер N в значении 
фильтра должен быть равен биту N в идентификаторе 
принимаемого кадра для успешного прохождения этого
кадра через фильтр. Если бит номер N в маске 
выставлен в 0, то биты номер N в значении фильтра и 
идентификаторе принимаемого кадра не сравниваются.

Например, установить аппаратный фильтр контроллера
на прием только кадров с идентификаторами от 0x0 до 
0x7 включительно: Filter code = 0x0, Filter mask = 0xfff8, 
здесь маска 0xfff8 указывает, что первые три бита 
идентификатора не участвуют в сравнении, а остальные
должны совпадать с 0. Таким образом, через фильтр 
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будут проходить кадры с идентификаторами от 0x0 до 2
в степени 3 минус 1 (т.е. 0x7). Другой пример, 
установить аппаратный фильтр контроллера на прием 
всех кадров: Filter code = 0x0, Filter mask = 0x0.

• Пункт меню «Тайм-аут передачи [Write timeout]» – 
вызывает диалог установки тайм-аута на отправку 
CAN-кадра в сеть.

4.6. Информация об ошибках сети CAN

Индикатор  ошибки  загорается  красным  цветом  при  ее
появлении.  Для  сброса  индикаторов  используйте  кнопку
аппаратного сброса CAN-контроллера «Сброс [Reset]».

• "EWL     error warning limit" – Error Warning Level, один
из  аппаратных  счетчиков  ошибок  CAN-контроллера
превысил уровень предупреждения (по умолчанию 96);
кроме  указаных  в  пункте  WTOUT, причиной
возникновения этой ошибки могут быть помехи в сети
(согласно спецификации Bosch CAN 2.0);

• "BOFF    bus off" – контроллер отключен от сети из-за
ошибок (один из аппаратных счетчиков ошибок достиг
предельного  значения  255);  При  наступлении  этого
события  CAN-контроллер  автоматически  переходит  в
состояние INIT;
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• "HOVR    hardware overrun" – произошло переполнение
аппаратной  приемной  очереди  CAN-контроллера
(безвозратно потерян один или несколько полученных
кадров), причина – большой поток кадров в сети, ЦПУ
не  успевает  вынимать  кадры  из  аппаратной  очереди
контроллера;

• "SOVR    software overrun" – произошло переполнение
программной  приемной  очереди  драйвера
(безвозвратно потерян один или несколько полученных
кадров),  причина  –  большой  поток  кадров  в  сети,
пользовательское  приложение  (в  данном  случае
программа  CANwise)  не  успевает  вынимать  кадры из
программной очереди драйвера;

• “WTOUT    write  timeout  occured"  –  кадр  не  был
отправлен в  течении  стандартного  временного
интервала,  ошибка  может  возникнуть  если  нет
соединения  с  сетью  (например,  обрыв  кабеля,  нет
других  контроллеров  в  сети,  несоответствие
выставленных  скоростей  передачи  у  контроллеров  в
сети);
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4.7. Информация о канале ввода-вывода и 
состоянии CAN-контроллера

• channel – номер используемого канала ввода-вывода;

• state – текущее состояние CAN-контроллера канала – 
INIT или RUNNING.

• hw overruns – количество возникших переполнений 
аппаратной приемной очереди CAN контроллера (этот 
счетчик сбрасывается в ноль при аппаратном сбросе 
контроллера). Аппаратное переполнение возникает в 
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случае когда контроллер получает из сети кадр и 
обнаруживает что аппаратная очередь заполнена. Тогда
контроллер сбрасывает полученный кадр (кадр теряется
безвозвратно) и генерирует прерывание, счетчик 
показывает количество таких возникших прерываний;

• sw overruns - количество возникших переполнений 
программной приемной очереди драйвера CAN 
контроллера (этот счетчик сбрасывается в ноль при 
аппаратном сбросе контроллера). Программное 
переполнение возникает в случае когда драйвер 
получает от контроллера прерывание о получении 
кадра из сети (в этот момент кадр уже находится в 
аппаратной очереди контроллера) и обнаруживает что 
программная приемная очередь заполнена, тогда 
драйвер сбрасывает полученный кадр (кадр теряется 
безвозвратно) и увеличивает счетчик программных 
переполнений;

• baud rate – текущая скорость передачи;

• filter code, filter mask – код и маска приемного фильтра 
(выставленного пользователем);

• frame format – используемый формат кадров;

• base address – базовый адрес области памяти куда 
отображаются  регистры CAN-контроллера;

• irq – номер линии прерывания используемой CAN-
контроллером канала;

• board – номер платы CAN-интерфейса, который 
содержит CAN-контроллер используемого канала 
ввода-вывода;

• board name – название платы CAN-интерфейса;
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• board manufacturer – имя компании производителя 
платы;

• CAN chip – тип CAN-контроллера;

• Ниже выводятся текущие значения регистров 
конкретного CAN-контроллера установленного на 
аппаратном CAN-интерфейсе; например, для 
контроллера SJA1000 назначение каждого регистра и 
смысл его значений приводятся в документации на 
Phillips SJA1000;

4.8. Завершение работы

Для завершения работы программы выберите «Файл->Выход 
[File->Quit]».

4.9. Работа с сеансами

CANwise  позволяет  сохранять  состояние  программы  между
сеансами работы в файл.  Файлы сеансов  имеют расширение
.cws. 

Для  сохранения  сеанса  работы  выберите  «Файл->Сохранить
сессию  [File->Save  session]»,  затем  в  появившемся  диалоге
выберите файл.

Для  загрузки  сохраненного  сеанса  используйте  кнопку
«Загрузить сессию [Load session]»  стартового диалога выбора
канала  (см.  пункт  Запуск  программы),  или  меню  «Файл-
>Загрузить сессию [File->Load session]». 

В ОС Windows загрузить сохраненный сеанс можно двойным
щелчком мыши на файле сеанса. 

В ОС Linux  загрузить сохраненный сеанс можно передав имя
файла сеанса в качестве первого параметра. Например,
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canwise /root/cwses-ch0.cws

4.10. Установка плагинов

Примечание:  в  CANwise  версии  3.x  изменен  интерфейс
плагинов,  поэтому  модули  версии  2.x  не   работают  в
составе CANwise 3.x.

Для  установки  необходимо  поместить  файл  плагина  (в  ОС
Windows -  это  файл  с  расширением  .dll,  в  ОС  Linux –  с
расширением  .so)  в  установочную директорию  CANwise,  то
есть  директорию  где  лежит  исполняемый  файл  программы.
После этого необходимо перезапустить программу. 

Например, если в ОС Windows CANwise установлена в  папке
C:\CANwise-3.x,  то  для инсталляции достаточно  скопировать
файл плагина в директорию  C:\CANwise-3.x, и перезапустить
программу.
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5. ИСПОЛЬЗОВАНИЕ CANMONITOR

Плагин  CANmonitor позволяет  работать  с  сетью  CAN на
канальном уровне, а именно:

• Выводит на экран все пакеты проходящие по сети;

• Позволяет отправлять пакеты произвольного 
содержания в сеть;

• Записывать весь трафик (как принимаемые так и 
отправляемые кадры) в лог-файл для дальнейшего 
анализа;

При установленном соединении с сетью CANmonitor выводит
все проходящие по сети кадры в свое рабочее окно.
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Кнопка  «Очистить  вывод  [Clear  Output]»  очищает  рабочую
область вывода модуля и сбрасывает счетчики полученных и
отправленных кадров.

Раскрывающийся  список  перед  кнопкой  «Очистить  вывод
Clear Output» позволяет выбрать формат вывода поля данных
полученного  CAN-кадра:  HEX –  шестнадцатеричный формат,
DEC – десятичный, ASC – формат ASCII, BIN - двоичный.

Кадры выводятся на два экрана: 

• «Бегущий вид [Scroll view]»  - каждый кадр выводится в
виде отдельной строки добавляемой снизу;

• «Списочный вид [List View]» - кадры выводятся в виде
фиксированного списка идентификаторов (столбец ID).
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5.1. Вывод данных в формате «Бегущий вид 
[Scroll view]»

Полученные/отправленные  CAN-кадры  выводятся в  виде
строк с полями фиксированного размера:

EV NUM/ERR F/F ID LEN R/D D0 D1 D2 D3 D4 D5 D6 D7 TIMESTAMP DD MM YYYY TIME

Здесь:

• EV [событие]:  RX  -  полученный,  TX  -  отправленный
кадр,  ER  -  асинхронная ошибка сети (см.  следующий
пункт);

• NUM/ERR  [номер  кадра]: счетчик
полученных/отправленных кадров; счетчик ведется до 9
999 999 кадров, затем обнуляется; выводится в формате
десятеричных чисел; 

• F/F [формат кадра]:  SFF - кадр стандартного  формата
(идентификатор имеет длину 11 бит), EFF указывает на
кадр  расширенного  формата  (идентификатор  имеет
длину 29 бит);

• ID  [идентификатор]:  значение  идентификатора  кадра,
выводится в формате шестнадцатеричных чисел;

• LEN [длина]:  длина поля данных в байтах (от  0 до 8
байт);

• R/D (RTR/HEX/DEC/ASC/BIN): RTR - кадр RTR (поле
данных отсутствует), HEX/DEC/ASC/BIN - кадр данных
в выбранном представлении;

• D0  …  D7  [байты  данных]  –  значения  байтов  поля
данных кадра  от  первого  до  восьмого;  если  получен
RTR кадр это поле оставляется пустым;
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• TIMESTAMP  [значение  отметки  времени  в
микросекундах]  –  метки  времени  проставляются
драйвером  в  момент  извлечения  кадра  из  регистров
CAN-контроллера  (позволяет  оценить  интервал
времени  между  моментами  приема  кадров),  для
отправленных кадров поле отсутствует;

• DD MM YYYY TIME[текущая дата и время] — формат
ДД.ММ.ГГГГ  ЧЧ:ММ:СС.МЛС,  здесь  МЛС  —
миллисекунды. Дата и время выводятся для текущего
часового пояса компьютера (localtime).

Например: 

RX 0000004 EFF 0000001E 2 HEX   01  0B   0199968750 11.03.2012 19:46:07.867

означает,  что  получен  кадр  с  порядковым  номером  4,
расширенного формата (EFF – длина идентификатора 29 бит)
с  идентификатором  0x1E, длина  данных  2,  байты  данных
выведены в шестнадцатеричном формате (HEX), первый байт
данных  равен  0x01,  второй  –  0x0B,  отметка  времени
0199968750 микросекунд, дата - 11.03.2012 19:46:07.867.

Обнаруженные  в  процессе  работы  ошибки  выводятся
асинхронно  наряду с  отправленными и  принятыми  кадрами
(описание ошибок см. в пункте «Информация об ошибках сети
CAN»):

• “ER WTOUT   WRITE TIMEOUT       OCCURED  N
TIMES";

• "ER EWL     ERROR WARNING LIMIT OCCURED  N
TIMES";

• "ER BOFF    BUS OFF             OCCURED N TIMES";
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• "ER HOVR    HARDWARE OVERRUN    OCCURED N
TIMES";

• "ER SOVR    SOFTWARE OVERRUN    OCCURED N
TIMES";

5.2. Вывод данных в формате «Списочный вид 
[List view]»

Кадры  выводятся  в  виде  фиксированного  списка
идентификаторов (столбец ID). 

Каждый  идентификатор  сопровождается  следующими
данными:

• столбец EV – событие (RX, TX);

• столбец  NUM  –  количество  полученных  кадров  с
данным идентификатором;

• столбец F/F — формат последнего полученного кадра;
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• столбец R/D – тип  последнего полученного кадра (RTR
или кадр данных);

• столбец D0..D7 – поле данных последнего полученного
кадра;

• столбец  TIMESTAMP  –  отметка  времени  последнего
полученного кадра;
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5.3. Передача кадров сеть

Диалог  передачи кадров  позволяет  отправлять  в  сеть
одиночную или циклическую группу разных  CAN-кадров  (от
1-го до 32-ух штук) с задаваемыми пользователем задержками
между ними.  Диалог  передачи вызывается нажатием кнопки
«Отправка кадров [Transmit frames]».

Процесс передачи запускается кнопкой  «Transmit».  Алгоритм
просматривает  слоты  CAN-кадров  (строка  элементов
управления),  и  если  переключатель  слота   on/off  включен –
кадр  отсылается  в  сеть,  затем  следует  задержка  времени
указанная в поле «Delay» и происходит переход к следующему
слоту.  Процесс  повторяется  для  всех  слотов  столько  раз,
сколько указано в поле ввода «Повторить [Repeat]».

Кнопка  «Отменить  [Cancel]»  прерывает  текущий  процесс
передачи,  кнопка  «По умолчанию  [Defaults]»  сбрасывает  все
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поля  в  значение  по  умолчанию,  кнопка  «Закрыть  [Close]»
закрывает диалог.

Каждый  слот  (строка  элементов  управления) задает
содержание отправляемого в сеть кадра:

• On/Off – включение/выключение слота;

• ID – идентификатор кадра;

• F/F –  формат  кадра  (SFF –  стандартный,  EFF –
расширенный);

• RTR – флаг кадра запроса  на передачу  RTR (кадр не
имеет поля данных, но  имеет задаваемую длину поля
данных);

• LEN – длина поля данных в байтах (от 0 до 8);

• [D0... D7] – байты поля данных с первого до восьмого;

• Delay (msec)  –  временная  задержка  между  посылкой
кадров в миллисекундах;

Каждый  отправленный  в  сеть  кадр  заносится  в  историю,  и
каждый слот можно восстановить из истории. 

Для  восстановления  необходимо  кликнуть  правой  кнопкой
мыши на номер слота и во всплывшем меню выбрать пункт
«Восстановить из истории [Restore from history]».
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Появившийся  диалог  позволяет  выбрать  кадр  из  списка
отправленных ранее (двойной клик мыши на нужной строке
или выбор нужной строки и нажатие кнопки «Ok»).

5.4. Запись трафика в лог-файл

Переключатель  «Журнал  выкл./Журнал  вкл.  [Logfile
OFF/Logfile ON]» вызывает диалог выбора файла, в который
модуль  CANmonitor автоматически  записывает  все
принимаемые/отправляемые кадры и возникающие ошибки в
виде  аналогичном  тому,  как  они  появляются  на  экране
«Бегущий вид [Scroll view]» (поле данных кадра записывается
в  шестнадцатеричном  виде). Запись  ведется  в  виде  строк
текста в кодировке  UTF-8.  При включенной записи лога имя
выбранного файла высвечивается во всплывающей подсказке
(tooltip) при наведении курсора мыши на переключатель.
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